Test Bank - Chapter 2


Creating a Presentation:


Content, Formatting, and Animation


Chapter Objectives 


Use the Outline view to create and edit a presentation; display and hid text within the Outline view.


Check the spelling in a presentation.


Apply a design template to a presentation.


Add transition effects to the slides in a presentation; apply animation effects to the bullets and graphical objects in a specific slide.


Modify the template of an existing presentation by changing its color scheme and/or background shading.


Explain the role of masters in formatting a presentation; modify the slide master to include a company name.


Explain how the AutoContent Wizard facilitate the creation of a presentation.


Chapter Outline


Objectives


Overview


Creating a Presentation 


	The Outline View


	The AutoContent Wizard


Templates


Hands-On Exercise 1: Creating a Presentation


Creating a Slide Show


AutoLayouts


Hands-On Exercise 2: Animating the Presentation


The AutoContent Wizard


Fine-Tuning a Presentation


	The Color Scheme


	The Background Shading


	PowerPoint Masters


Hands-On Exercise 3: Fine-Tuning a Presentation


Summary


Multiple Choice


Which of the following PowerPoint presentation elements are visible in Outline view?


Charts


Clip art


Both charts and clip art


Neither charts nor clip art


answer:	d


�



Which of the following PowerPoint presentation elements are visible in Slide Sorter view?


Charts


Clip art


Both charts and clip art


Neither charts nor clip art


answer:	c





Which view lets you display the text and graphics of multiple slides?


Outline view


Slide Sorter view


Both Outline view and Slide Sorter view


Neither Outline view nor Slide Sorter view


answer:	b





You are in the Outline view. How do you know whether a slide contains a graphic element?


The graphic is displayed next to the slide


The slide title is displayed in boldface


The slide icon next to the slide title is different from the icon of a text-only slide


You cannot determine in Outline view which slides contain graphics


answer:	c





Which of the following key(s) demotes (indents) an item in Outline view?


Shift+Tab


Shift+Right Arrow


Ctrl+Right Arrow


Tab


answer:	d





What happens if you complete a bullet, press the enter key, then press the Tab key?


A new bullet will be created and will be indented one level to the right


A new bullet will be created and will be moved one level to the left


A new bullet will be created at the same level as the current bullet


The bullet symbol is changed


answer:	a


Which view displays multiple slides while letting you change the text in a slide?


Outline view


Slide Sorter view


Both (a) and (b)


Neither (a) nor (b)


answer:	a





Which of the following design specifications is preset in a PowerPoint template?


Color scheme


Arrangement of placeholders on each slide


Size of bulleted text


All of the above


answer:	d


�



Which of the following statements is true about PowerPoint’s ability to correct spelling?


It will automatically correct all misspelled words as you type them


It will automatically correct only those words in the main spell check dictionary


It will automatically correct only those words defined in the AutoCorrect feature


It cannot automatically correct any misspellings


answer:	c





Assume you are in Outline view and have collapsed the outline so that only the titles are visible. What happens if you click on the third slide and drag it to the end of the presentation?


The slide title is moved, but the bulleted items remain and are now included on slide two


The slide title remains, but the bulleted items are moved to the end of the last slide


The entire slide, including title, bullets, and graphics, is moved to the end of the presentation


This situation is not possible; it is not possible to drag a slide in Outline view


answer:	c





Which key combination can be used to select all the slides in Outline view?


Ctrl+End


Ctrl+A


Alt+End


Alt+A


answer:	b





Suppose you are working in Outline view and press Ctrl+A. What happens?


The PowerPoint annotation tool is displayed


The mouse pointer returns to an arrow


The presentation is checked for spelling


All the slides in the presentation are selected


answer:	d





Where will the insertion point be after you complete the text for a bullet in the outline view and press the enter key?


On the next bullet at the same level of indentation


On the next bullet at a higher level of indentation


On the next bullet at a lower level of indentation


Impossible to determine


answer:	A





Which of the following is true?


Shift + Tab promotes an item to the next higher level


Shift + Tab demotes an item to the next lower level


Tab promotes an item to the next higher level


All of the above are false


answer:	a





Which of the following is true about the Outline view?


The position of a slide may be changed by dragging its icon


All slides display the identical icon regardless of content


The text and graphics are displayed for each slide


All of the above are false


answer:	a





What advantage, if any, is there to collapsing the Outline view so that only the slides titles are visible?


More slides are displayed at one time, making it easier to rearrange the slides in the presentation


Transition and build effects can be added


Graphic objects become visible


All of the above


answer:	a





The AutoContent Wizard provides suggested presentations for:


Communicating bad news


Selling a product, service, or idea


Both (a) and (b)


Neither (a) nor (b)


answer:	c





Which of the following PowerPoint features changes the way slides move on and off the screen?


Transitions


Builds


Slide Navigator


All of the above


answer:	a





Which of the following actions could you take to add a graphic element to a slide which currently contains only text bullets?


Click the Graphic button on the Formatting toolbar, then drag the crosshair to indicate the size and location of the graphic


Click the Slide Layout button on the status bar and select a layout with text and graphics


Switch to Slide Sorter view and drag a graphic element from another slide to this slide 


It is not possible to add a graphic to an existing slide


answer:	b





In which view can you change the slide layout to include a graphic element?


Outline


Slide Show


Slide


All of the above


answer:	c





You are in the Slide Sorter view. How can you determine whether a slide includes a transition effect? 


The slide title appears in boldface


The slide title blinks


A special slide icon appears below the slide 


You cannot determine in Slide Sorter that a slide contains a transition effect


answer:	c





The AutoContent Wizard


Creates a general outline for a presentation


Adds “boiler-plate” content to each slide in one of 10 different topical areas


Automatically spell checks a presentation as you create it


Prompts you to enter content with questions such as “What is the title of this slide?”


answer:	a





Where can you find the Slide Transition command?


On a shortcut menu


On the Tools menu


On either a shortcut menu or on the Tools menu


On neither a shortcut menu nor the Tools menu


answer:	c





How do you change the number of slides displayed on the screen at one time in the Slide Sorter view?


Select the number of slides from a shortcut menu


Change the magnification using the Zoom control box


Select all the slides in the presentation; then drag the lower right corner of a slide to reduce/enlarge all the slides


It is not possible to change the number of slides displayed in Slide Sorter view


answer:	b





You are rehearsing a presentation in Slide Show view, but do not see any bullets on the current slide (which you know has three bullets). What is the most likely explanation?


The bullets are defined with a build effect and have not yet been displayed


The bullets on this slide are hidden


The option to suppress the bullets was selected


The Show Titles Only command was executed in the Outline view


answer:	a





Which of the following presentation elements can be displayed with a build effect?


Bullets


Graphic images


Both bullets and graphic images


Neither bullets nor graphic images


answer:	c





Which of the following elements can have its color changed within a template?


The title text


The bullet text


The background


All of the above


answer:	d





Which color scheme would be best for a presentation that will be shown on transparencies instead of displayed using the computer?


Blue background, yellow text


Green background, white text


White background, dark blue text


Any background is equally suitable for transparencies and/or on-screen presentation


answer:	c


�



Light backgrounds are most suitable for


On-screen presentations


35mm slides


Overhead transparencies


All of the above


answer:	c





Dark backgrounds are most suitable for


On-screen presentations


35mm slides


Both on-screen presentations and 35mm slides


Neither on-screen presentations nor 35mm slides


answer:	c





What is the easiest way to add a logo to all the slides in a presentation?


Select all the slides and click the Add Graphic button on the Standard toolbar


Use the View menu to add the logo to the slide master


Add the graphic to the first slide, select the graphic, press Ctrl+C to copy it to the clipboard, select all the other slides and click the Paste icon on the Standard toolbar


Drag the graphic from one slide to the others in Slide Sorter view 


answer:	b





Which of the following is true?


Slides can be added to a presentation after a template has been selected


The template can be changed after all of the slides have been created


The template can be changed at any time when you are editing your presentation


all of the above


answer:	a





What is the easiest way to add a corporate name to every slide (except the title slide) in a presentation?


Add the corporate name to the handout master


Add the corporate name to the slide master


Either (a) or (b) would be appropriate


Neither (a) nor (b)


answer:	b





Which of the following can be changed without changing the template?


The color scheme 


The background shading


The slide master


Both (a) and (b)


answer:	d





Which PowerPoint menu allows you to change the slide master?


File


Edit


Tools


View


answer:	d





Which key should you press while clicking the Slide View button at the bottom of the screen if you want to see the slide master?


Ctrl


Shift


Alt


Tab


answer:	b





How many background colors can you specify when creating a slide with a shaded fill background? 


1


2


5


10


answer:	b





Which of the following can be printed for a presentation?


The slides in miniature (up to six to a page)


The notes pages


The outline


All of the above


answer:	d





You are reviewing a PowerPoint presentation in Slide Show view and notice that the bullets are appearing from bottom to top. What is the most likely explanation for this?


The slide transition was incorrectly specified


The reverse order build effect was selected


The order of the slide was changed using Slide Sorter view


The slide master contains an error


answer:	b





Using animation effects you can


Build the slide a bullet at a time


Build the bullets a letter at a time


Build the bullets a word at a time


All of the above


answer:	d





In which view do you see the animation effects for a slide?


Slide Show view


Outline view


Both Slide Show and Outline view


Neither Slide Show nor Outline view


answer:	a





You are in the Slide view and click the Slide Layout button on the status bar. Which of the following layouts will be changed?


The layout of the current slide


The layout of all the slides in the presentation


The layout of the slide master


All of the above


answer:	a





You are working on a PowerPoint presentation and execute the command to apply a design template. Which slide(s) does the command affect?


Only the current slide


All slides in the current presentation


All new presentations subsequently created in this session


All existing presentations subsequently opened in this session


answer:	b





How do you select a slide in Outline view?


Click the slide icon


Click the slide number


Click either the slide icon or the slide number


It is not possible to select a slide in Outline view


answer:	c





Which PowerPoint feature creates a general outline of your presentation after you enter the type, the style (professional or contemporary), and the approximate duration of the presentation you want to create?


Build effects


Transition effects


AutoContent Wizard


AutoLayouts


answer:	c





Which of the following do you have to select in order to complete a presentation using the AutoContent Wizard?


The template


The slide layout


The background color scheme


None of the above


answer:	d





Which of the following is the most important element in a PowerPoint presentation?


The content


The template


The slide layout


The transition and build effects


answer:	a�



Clicking the Demote button on the Outline toolbar has the same effect as


Pressing Tab


Pressing Shift+Tab


Clicking the Decrease Indent button on the Formatting toolbar


Pressing Ctrl+Home


answer:	a





Clicking the Promote button on the Outline toolbar has the same effect as


Pressing enter, following by Tab


Clicking the Increase Indent button on the Formatting toolbar


Pressing Tab


Pressing Shift+Tab


answer:	d





Which of the following can be used to change the background colors in a slide?


AutoLayout


Apply Design Template


AutoContent Wizard


Slide Transition


answer:	b








True/False





It is not possible to determine whether a slide contains a graphic element while in Outline view.





answer:	F





When a bullet is promoted, it is moved one tab stop to the left.





answer:	T





Text in a PowerPoint presentation may be moved using the Cut and Paste commands.





answer:	T





The select-then-do methodology implies you select the desired formatting after which you select the text to which the formatting is to apply.





answer:	F





The AutoContent Wizard provides you with complete content for most of the slides in a presentation.





answer:	F





When you switch to Outline view from Slide view, the outline will automatically be collapsed so you will only see the slide titles.





answer:	F





To create a new bullet at the same indent level as the current bullet, press the enter key followed by the Shift+Tab combination.





answer:	F





To create a new bullet at the next higher level than the current bullet, press the enter key followed by the Shift+Tab.





answer:	T





To create a new bullet at the next lower level from the current bullet, press the enter key followed by the Tab key.





answer:	T





AutoCorrect functions in PowerPoint the same way as it does in Word.





answer:	T





It is not possible to check a presentation for misspelled words.





answer:	F





Transitions control the way in which one slide moves off the screen and the next slide appears.





answer:	T





If you use a build effect on a slide, you cannot use a transition on the same slide.





answer:	F





Both build and transition effects are available through the Tools menu.





answer:	T





It is possible to add sound to a bullet in a PowerPoint presentation using a special build effect.





answer:	T





Build effects can be applied to text objects only, not to charts or clip art.





answer:	F





Once you have selected a layout for a slide, you cannot change it to add a new object at a later time.





answer:	F





A special icon indicates which slides contain transition effects while in Slide Sorter view.





answer:	T





The Zoom Control box enables you to change the number of slides displayed in Slide Sorter view.





answer:	T





The AutoContent Wizard automatically creates the content of your entire presentation for you when you answer a few questions.





answer:	F





You can drag and drop slides to a rearrange the order o
